
 

Memo: 
To: UIX Analysts & Future Gephi-users 
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Date: August 2013 

Re: Methods for data analysis and visualization using Gephi 
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1. What is Gephi? 
a. Gephi is an open-source platform to process, visualize, and perform statistical analysis on 

network data.  The latest version can be downloaded for free here: https://gephi.org/ 

b. This methodology uses the working example of the Urban Innovation Exchange (UIX) survey data 

collection.  By August 2013, 82 innovators and their corresponding projects were surveyed and 

asked to list other organizations or people that were critical collaborators, community partners, 

funders, or the like.  The objective of this data analysis is to capture the growing network of social 

innovation and entrepreneurship in Detroit and better understand intrapersonal support systems.  

(Ask Kat or Jessica for further context about this project if needed!)   

 

2. Preparing data   
a. Most simply, network data must include “nodes” (in this example, unique project names and the 

people associated with them) and “edges” (how projects are connected to each other). 

b. Clean data to form a matrix that must include a “Source” project and a “Target” project with 

unique identifiers.  (For UIX, this reads as “Fresh Media Group named Allied Media Project as a 

collaborator.)” 

https://gephi.org/


 

2 

 

08/05/2013            2 

  
 

c. Prepare two .csv files for Gephi: 1) nodes table; and 2) edges table. 

1) A nodes table is most basically structured to have a unique Id and Label.  Other 

attributes corresponding to each node can be included in columns to the right and 

later used as filtering characteristics. (In our example, this includes a binary flag field for 

UIX projects versus other un-related organizations named as community partners). 

2) An edges table includes the Source and Target Id columns and edge “Type”.  Type can 

be “directed” (an arrow) or “undirected” (like reciprocal relationships).   An additional 

“Label” column can be added to include edge names (for UIX, these were coded to 

distinguish advisor or mentorship from board or committee members and so on.) 

 

  
 

3. Importing data (.csv) to Gephi 
a. Open Gephi and select “New Project” in the Welcome window 

b. Click the “Data Laboratory” tab  “Data Table”  “Import Spreadsheet” 

 
 

c. Import both Nodes and Edges files; order of import does not matter.  When choosing Nodes file, 

make sure that “As Table:” dropdown matches “Nodes Table.”  Repeat with Edges file.   

d. Continue through with default Import Settings. 
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e. When both files are imported successfully, toggle between “Nodes” and “Edges” under “Data 

Table” to display data.  Save workspace at this time.   

 

4. Visualizing 
a. Basics 

1) Switch from “Data Laboratory” tab to “Overview” tab.  Imported raw data will display. 

 
2) Find the number of displayed nodes and edges in the top right corner under “Context”.  

The number of nodes should be the number of unique ids and labels imported.  Edges 

should also be equivalent or may be smaller if there are multiple ties between the same 

source and target; rather, these are displayed as the thickest arrows.   

3) Zoom using mouse scroll ball.  Right click to adjust image in screen. 

 

b. Frequently used icons 

 

 

 
 

c. Ranking 

 Center on graph.  Reset zoom 

Reset size, color, etc.  Undo ranking or layout 
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1) Adjust the size and color of nodes and edges based on “degree”, meaning number of 

ties and connectedness. 

 

 
d. Layout 

1) Change the layout of the network map.  This particular function takes a bit of 

experimenting and tinkering, especially with big networks where nodes often overlap.  

The Gephi “Layout Tutorial” found here is particularly helpful: https://gephi.org/users/ 

 

 
 

 

 Color; Size/Weight; Label Color; Label Size/Weight 

 Drop down to choose rank parameter 

 See preset color ramps 

Rank nodes or edges or both  

 

Show a color-coded 

results table  

 

 Choose from multiple layouts in the dropdown 

menu.   

 

Note that not all options are a layout – some are 

adjustments to your current layout, like “Rotate.”   

 Select a layout 

Layout description  

 

Click on a category to see a short description at 

the bottom and adjust numbers to alter layout 

display.  Reset to defaults at bottom. 

 

 

 RUN!  (And Stop your layout) 

https://gephi.org/users/
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2) Extra lay-out tips -- consider installing additional plug-ins!     

  

e. Filters and queries 

1) Use the “Filter” tab and complimentary “Query” function to control the display size of 

your network, this is useful for creating an accessible, readable image.  The “Filter” tab is 

located on the right panel.   

 

 
 

   
 

2) Clicking “Filter” twice will un-do the selected filter.  Or right-click on any selected filter to 

“Remove.”   

3) If you are running multiple filters and queries, it becomes helpful to export to a new 

workspace after each filter (the middle icon next to “Reset” below “Filters” tab).  This also 

re-calculates the network rankings as they change through filters.   For example, certain 

UIX projects have the greatest out-degree when analyzed in the full-network, but others 

are highest in the filtered network of only UIX-featured projects. 

 

    

Partition queries work with attributes.   

Expand “Partition” and see all attribute columns. 

In UIX, this is used to display a network that is only 

UIX-featured projects, designated by a flag field. 

 

 

Topology queries work with nodes and edges 

statistics.  For example, expand degree range to 

see the range of degrees in your network.  In UIX, 

this is 0-30.  If we only wanted to display nodes 

with an edge tie (degree > 0), we could run a 

query as shown below. 
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f. Partition 

1) Partitioning happens in two places in the Gephi workspace; first, as a filter and then as a 

nodes and edges color/size parameter. 

 

   
 

2) Once you set a query for an attribute using “Partition”, you can also control “Partition” in 

your layout.  Go to “Window” drop-down and choose “Partition.”  It should appear as a 

tab next to “Ranking” on the left. 

 

    
 

 In the Filters tab, expand “Attributes” then “Partition.”  Any 

attribute column headings will appear with “Node” or “Edge” 

specified in parenthesis. 

 Choose an attribute under “Partition” and click + drag into “Queries”. 

 Results of partition appear here.  You can select 

individual attributes to filter, but it is not necessary.  

 From the “Partition” tab, you can toggle between Nodes 

and Edges, depending on your selected attribute. 

Since we queried “Partition (Tie)” in our “Filter”, we see “Tie” in 

the “Edges” dropdown.  You may have to “Refresh” first. 
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g. Statistics 

1) Beyond layouts, Gephi also performs high-speed, advanced social network analysis.  

Statistics about the network’s connectivity can be calculated and exported as a .csv. 

 
 

 
 

2) Quick definitions of common metrics for statistical analysis: 

1. Centrality – most fundamental term and used in sociology to indicate how well a 

node is connected  

2. In-degree –how many edges point to a node or how “inwardly” connected a 

node is 

3. Out-degree – how many connections a node points to or a node’s “outward” 

connections 

4. Degree – in-degree plus out-degree 

5. Modularity – community detection for hierarchal data 

6. Reciprocity – reciprocal ties indicate stability 

 Run a calculation.  See an instant “Report.”  Find 

newly stored data in “Data Laboratory”  “Data 

Tables”  “Nodes.”   

Run numerous calculations as desired, they will build 

more columns to the left in the “Nodes” table. 

 Choose “Tie” to assign unique colors to network 

edges based on an attribute. 

Right-click anywhere in the window to 

“Randomize” the default color spectrum. 

OR right-click an individual color to set RGB. 

 

 
 Use “Show Pie” to see a chart break-down of the 

selected edge attribute. 
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h. Preview 

1) Control the aesthetics of your visual output in “Preview” after setting the layout, filters, 

partitions, and/or ranks in “Overview.”  Preview offers better control for labeling and font 

sizes especially.  

 

 
 

i. Export 

1) Gephi exports images in three formats: .pdf, .png, and .svg.  You can also export a 

spreadsheet from the Data Laboratory as a .csv with newly calculated statistics.   

2) Note that long labels or distant nodes may be cut off during the export process for 

images.  To avoid this, choose “Options” in the export window and adjust page 

orientation, widen margin widths, or select transparency.  

 

 
 

Use these controls to control visual network 

display.  Defaults/important adjustments include 

curved or directed edges, edge color (set to 

“original” if you have re-colored your edges 

through a partition), and node labeling display.   

 

Click “Refresh” after any adjustments to see the 

result.  

 

“Reset Zoom” at the bottom left of the display 

screen to re-center adjusted graphs. 
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5. Sample visuals and network maps from UIX 
a. This is a 12-step guide to produce 6 images for the UIX network, illustrating the full network and 

filtering down to only UIX projects.   

b. The steps are illustrated with screen shots and the bounded pdf exports follow.  All images were 

produced in the same work session. 

c. This series of networks is meant to show ways to use Gephi to think about “zooming in” on 

particular aspects of a network through filtering.  The images also exemplify the two distinct 

levels of analysis in the UIX data (the entire network of 550+ organizations and the survey sample 

of 82 UIX-featured projects) 
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Step1: Import data. No Queries. Step 2: Rank nodes by size and apply Circular Layout by 

UIX Attribute 
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Step 3: Partition nodes by UIX binary, assign colors.  Apply Noverlap layout after Circular Layout.  

Partition edges by Tie, assign colors.  No queries are used yet.  Once we assign colors and size, these 

setting will carry through to all future steps unless noted to “re-apply”.   
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Step 4: Adjust aesthetic settings in Preview.  Export first image of full network with color-coded edges 

and nodes.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 5: To go from the full network to the “zoomed-in” arc display, drag the Partition(UIX) to Queries and 

select the flag field of UIX = 1.  Do not adjust layouts, rankings, or colors. 
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Step 6: Preview, reset zoom, and export image 2.  Do not change any previous aesthetic settings. 

 

 
 

Step 7: Return to Overview and export the filtered graph to a new workspace.  Once in a new 

workspace, re-apply Ranking of node size and color.  Re-apply Noverlap layout only.  This now displays 

the degree of connectedness between only UIX-featured projects. 
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Step 8: Preview and reset zoom.  Export the third image.  As a pdf, this should appear just like the second 

image, besides node size and color.  This way, they offer a comparison of two levels of analysis. 

 

 
 

Step 9: With a new image of UIX-only projects sized by their connectedness to each other, now make 

the image more readable through a new layout.  Re-apply Circular Layout, Nooverlap, and Rotate. 
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Step 10: Preview and Export image 4. 

 

 
 

Step 11:  Many nodes on this graph do not actually have any connections, but appear because they 

are UIX-featured projects.  We can remove these by running a Topology –Degree Range query 

between 1-6.   
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Step 12: Preview and export the fifth and final image of only nodes with an edge connections!  Now, to 

highlight each type of tie individually, export again to a new workspace and use the Partition (Tie) filter, 

and export each desired image (Images 6+).     
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